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Believe it or not it is time for 
another newsletter – to me it seems 
like only last week that Gwen was 
pestering me for articles, but appar-
ently it was 3 months ago – doesn’t 
time fly!

So here we are again, back in 
my Ramblings, as normal I don’t know quite where 
these are going to take me, I just sit at the keyboard 
and wait to see what comes out – normally some-
thing does. The articles I have produced (or will pro-
duce – at the moment I haven’t finished them) are 
varied again this month, so hopefully there will be 
something for everyone. If I have time I will have in-
cluded an article on web based email for those with 
this type of account – I say if I have time because I 
have written the article once this week (finished it on 
Tues 17th July), went into Hotmail yesterday to be 
astounded by a completely new layout – looks very 
different to the one before, with some new features, 
so will have to do the article again – wonderful.

On a different note, you will have noticed that 
I still haven’t made any changes to the club website, 
and in fact it has been unavailable on a few occasions 
while the hosts have had server trouble (we can’t do 
much about that). I have been made aware recently of 
new legislation for educational establishments re-
garding web pages, and their accessibility for people 
with disabilities – although the club does not come 
into the legislation, I think it would be good for us to 
try to follow it wherever possible (after all our slogan 
says “Providing computing assistance for all”), so the 
pages are in limbo while I try to redesign them for 
this – not an easy task, particularly when you have to 
think about partially sighted/blind using browsers 
that read the page content (in the normal American 



4

accent – but actually very impressive, I may try to set up a 
quick demo at a meeting). The underlying thought is that the 
internet is an information medium rather than purely a visual 
one. I intend to keep a check on everything I do for this, so 
will put something together for the newsletter when it is fin-
ished.

Think I had better stop there – not sure how much 
room I am being allocated for the Ramblings, and could 
probably keep going forever!

See you next time.
Adrian

YOUR FAVOURITE WEBSITE
This new addition to our newsletter is a slot where members rec-
ommend a website that they find interesting and why.  This one is 
recommended by Adrian and - I agree with him – it’s great fun.
The address is   http://www.helldesk.org.uk
The following is an excerpt from the site.

"Colouring by Numbers"
Helpdesk: Technical Support, how can I help you?
End User: Oh, hi there. I was wondering... how do I print a page 
from the company Intranet?
Helpdesk: Just click the 'Print' button on the toolbar, it's shaped 
like a little printer.
End User: That's great, thanks. Bye.
(The user rings off. A couple of minutes pass by, then the `phone 
rings again)
End User: Hello again. That page from the Intranet has printed 
off, but it's in black and white!
Helpdesk: (Thinks) Erm... yes, but isn't your printer a black and 
white only printer?
End User: Erm... yes...?

Now give us  your favourite.
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DIARY DATES
Yes, what you've all been waiting for, the updated 
list of meetings and subjects for this year - and the 
dates for next (assuming you don't decide to close 
the club at the AGM!). Those marked H/O will be 
"Hand's on" sessions. The list is not set in stone, if 
there is anything you would like to see, please let me know.

10th August
Word Processing stage 2 - H/O
14th September
Annual General Meeting -  PLEASE TRY TO ATTEND IF 
POSSIBLE
12th October
Making Music on the PC - Midi and beyond (change to 
previously advertised)
9th November
Desktop Publishing - H/O
14th December
General/Christmas Party

And for next year, the meeting dates will be...
11th January, 8th February, 8th March, 12th April, 10th May, 
14th June, 12th July, 9th August, 13th September, 
11th October, 8th November, 13th December

As normal, the June and December meetings 
will be on the "General" theme,   and the 
September meeting will be the AGM. As 
yet I have no idea of  what  next year’s 
meetings will contain, so please tell me 
what you want

Adrian
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Summer is with us once again.  A real, sunny 
summer too, for a change.  (Well, it was when I wrote this!)  Much 
too nice to be stuck inside on the old computer.  This is the weather 
to be out in the garden.  My husband and I spent a very pleasant day 
recently in a local village that had opened its gardens to the public.  
I  was rather amazed to find that the majority had one thing in   
common. They all had a string of CD’s shimmering above the    
cabbages, peas and lettuces.  They obviously make very good bird 
scarers and actually look quite attractive, reflecting all the colours 
of the rainbow as they gently twirl above the greenery.    Another 
garden had used one as a centre weight on a home made set of wind 
chimes.

I’m sure all of us have received these unwanted CD’s through 
the post from Internet servers and other advertising companies, as 
well as any failed CD’s you may have lurking about.  Have you 
ever considered to what other uses they may be put?  They could 
be turned into very stylish drinks coast- ers, or small, but shiny 
Frisbees.  How about sticking them on the wall as an unusual mir-
ror?  If you were really clever you could use one as a face of 
a clock.  And as festive decorations at Christmas their possibilities 
are endless.

I should be interested to hear of any other uses these versatile 
little CD’s have been put to.  Or other unwanted computer       
equipment, come to that.  I’ve yet to see any floppy discs used in an 
imaginative way.  Maybe, being square and black, it’s just because 
they are not so attractive as CD’s.  Or maybe I just haven’t been 
looking in the right places.   Perhaps we should run a competition 
for the most imaginative use for unwanted computer hardware,     
(or should that be software?)  I look forward to some interesting 
suggestions, so get e-mailing now.

In the meantime I shall turn my back on my 
computer and relax in the garden with a long, 
cool drink,  my glass resting on a stylish CD 
coaster  - of course.
Gwen

Gwen’s Corner
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Using Text Boxes in Microsoft Word

You probably think that you know almost all there is to know about 
using Word (or, if you are honest, think that you know nothing, and 
so Word surprises you on a regular basis). However, very few peo-
ple seem to have managed to get their heads around the idea of us-
ing text boxes – these are a wonderful way of presenting informa-
tion, but have one or two interesting problems all of their own!

a. Creating a text box.
1. This is the really easy part – to make your text box you 

need to have Word open, and a document ready for editing 
(either a new document or an existing one). To make the 
text box, click the page in the place you want the box, and 
then go to the Insert menu (on the toolbar which should be 
at the top of the page), and click the “Text box” option on 
the list.

2. At this point your cursor will change from the normal 
text cursor (I shaped) to a “cross hair” cursor (+ shaped), 
use this while holding down the left mouse button to draw 
an appropriately sized text box (can be resized later). When 
you are happy, release the mouse button and the box will be 
created.

This is a text box – the border is optional!
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Now is a good time to mention that Word treats a text box 
as if it was an image – so you can have it floating over text, or 
with text flowing all around it, if you so wish – an effect often 
used in magazines or newspapers to draw your attention to a 
particular item. To set these options, click in the box, and then 
RIGHT click with the mouse on the shaded border – a menu 
will appear by the mouse cursor, select the “Format Text Box” 
option from this, and the formatting menu will appear, with 
the following pages:

As you can see, you have a lot of ways to “tweak” the box
once it has been created.

3. And there you have it – your text box is created. Just 
choose your font/colour etc, and away you go!
4. Before getting carried away with your new found skill, 
there’s just a few things to remember – see below.

b. Working with text boxes
Text boxes are wonderful tools when creating long docu-

ments, as they provide a way of visually separating text. How-
ever, you will probably need to know at least some of the fol-
lowing skills to get on well with them.
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1. Setting the borders/indents.

This may sound trivial, but it can cause a great deal of 
trouble. When you create a text box it almost always uses the 
formatting of the preceding paragraph, and while everything 
looks fine on the page normally, as soon as you put text into 
your box you get bedlam!

The solution is quite simple. Click in the box, and then se-
lect all of the text (either using Edit>Select All, or by pressing 
[ctrl]+[a]). Now go to Format>Paragraph, and you will see a 
menu similar to the following:

Set these to suit your document – though it is always worth en-
suring that the Indentation is set to 0cm for both the Left and 
Right sides (it is sometimes possible for this to be set with a 
negative indent, which means that you text disappears off the 
edges of the box).

2. Linking to other boxes

Why would you need to link to another box – just wait until 
you have a text box continuing over a page, and you will soon 
find out!

Luckily this is also easy to solve. Start with the box you 
have already created, and now produce another box where you 
want the text to continue. Click into the first box, then again 
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RIGHT click on the shaded border, but this time select the “Create 
Text Box Link” option.

Your cursor will now change, into a Jug! Simply click the second 
text box to ‘pour’ the contents of the jug into the new text box –
and your text will magically appear.

3. Resizing or moving your text box

So, you didn’t get it right when you created it – shame on you! But, 
if like 99.99% of us you haven’t got the box quite right, don’t 
panic.

To resize the box, click it, and then move your attention to the 
shaded border. Midway along each of the sides is a white box. If 
you put your mouse cursor over this box it will change to a 2 
headed arrow (pointing either horizontally or vertically) – with the 
cursor like this, click the box and drag it to the desired height or 
width.

If the box isn’t in quite the right place, you need to click the 
box, and then move the mouse cursor over any part of the shaded 
border – the cursor will suddenly sprout 4 arrows! Click the shaded 
border with this cursor and you can drag the box wherever you 
want it to go.

There you have it, now you have no excuse when it comes to text 
boxes in Word.

Adrian Hooper
pysit-support@bath.ac.uk
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THE COMPUTRESS
I read recently an article by a lady who complained 
that all her troublesome computer’s faults are    
typically male.  I’ve been wondering lately if her 
masculine misbehaver might be induced to engage 
in online intercourse with my own computer so 

that they could work off their frustrations on each other.  You see, 
my computer is undoubtedly female.
     She is moody, broody, petulant and spiteful.  She gives me no 
warning as to where my fingers should not roam but should my   
tentative exploration unintentionally tickle her inhibitions she 
storms off into some utterly irrelevant region before freezing as 
solid as a glacier.  While her sulk lasts, no blandishments or flattery 
or abject apology can prevail.  You can prod the iceblock until you 
get chilblains but you will get no response until it suits my lady.  
She has turned her back on you and I can only assume she is       
gossiping with “Modam”.
     Unless you pronounce Modam’s name as if she were an honored 
customer entering an exclusive millinery department she won’t    
admit that you are there.  She often works with Catty, my computer, 
but fortunately for me, they frequently disagree and Catty has to   
forget her sulk to wail, 
           “I can’t make contact with Modam.”
So then, for a moment, I’ve got contact with a computer again. Even 
an irritable old man like me is better than nobody at all to moan at.  
I ask Catty if she is feeling unwell.  No answer.  I know that Catty 
has an extensive knowledge of all her inner organs, digestive,    
communicative or reproductive and will natter on endlessly about 
them but only to a woman.  When Alison, my daughter in law pays 
us a visit they yammer on together like the proverbial old dears over 
the garden wall.  And when Alison has finished buttering her up the 
old box even smiles at me.  For a little while Catty will allow me to 
talk to someone else---but she still makes it as difficult as she wants 
to.    Could this be a hint of jealousy?  Well, what do you think?
     About a month ago I sent a message to a lady to congratulate her 
on coming on-line.  It didn’t go through.  The mistake I had made in 
her address was so infinitesimal that only a nit-picking female could 
have found fault with it but I said “Sorry Catty”, (the kindest words 
I’ve spoken to her in six months) and cancelled the message.  I tried 
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to erase it several times, in several ways, according to several     
people’s practical suggestions.  Nothing worked.
     Then it became apparent that Catty had taken offence. She      
refused to tell me why, of course, but refused equally adamantly to 
allow me to forget that I had tried to send an innocent message to a 
lady.  Now, as if to remind me of my infidelity, every time I ask her 
if there is any Email in the box Catty erects a huge grey tombstone 
across the centre of the screen effectively blocking out the necessary 
information.  The inscription tells me that I tried to send a message 
to a lady and that it cannot be sent.  Of course it doesn’t tell me 
why, it just adds some algebraical expressions that are probably the 
dimensions of the cell in which Catty would like to confine her.   Or 
me.     
     Yes, I can get rid of the obstruction, temporarily, but how do I 
know what went on behind that big grey slab?  Did she block up the 
line as well?  Catty can be very devious when she tries.
     Then there’s Modam.  I had my difficulties with her when she 
refused to work. Just closed her eyes and played dead.  I felt sure 
there was nothing wrong with her intestines all tightly locked away 
in that impregnable chastity box so I decided to try a little           
psychology.  I talked to her without the usual exasperated invective 
and caressed her gently, all the way from her armour-plated   
mysteries to her passionless plugs.  Suddenly as I fondled and 
stroked her limp leads with sensitive fingertips she beamed at me.  
Two of her ruby red eyes lit up and yes, she was willing to work 
again. She still requires a little titillation now and again, but she is 
female after all.
     I wonder if Catty would appreciate similar attention?  I suppose I 
could give her a pretty background picture instead of Shepton    
Mallet Prison or introduce her to the paintbox to make up her 
mournful visage. I might even begin by changing her name and no 
longer threatening to boot her up.  You never know with females, it 
might even work.

Missing Toy.     

Handy Hint
Save yourself time by copying or moving several files at the 

same time.  Press the Ctrl key and, keeping it pressed down, click 
on each of the files or folders.  Release Ctrl key and copy as usual.
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Puzzle Time
Answers to the puzzle questions in the last newsletter.
1.  This is an 11+ type of question.  A young child would 
solve it by counting the letters  -
One     Two     Three     Four     Five     Six     Seven   
and so the next few must be   Eight     Nine     Ten,  etc. 
that is,  E   N   T   E , etc.

 2.  This is a trick, of course.  The extra ball is a red herring and so are 
the  four bags     -   there’s only one!  So also is the “average        
probability”  With two balls in the bag,  the possibilities are BB,  BW,  
WB,  WW  and so the chances of drawing a black ball are 1 in 2.

Surprise, surprise !!!

3. The simplest way of solving this is to use a Venn diagram.  If 
you’ve never heard of them, go on to the next section.  If you have, 
draw a large circle to represent the 36 guests.  Inside that, draw 
smaller intersecting circles to represent the different language -
speakers.  Write the appropriate numbers in the various sections, 
eg. where the French and English circles cross, write “6”.  Make sure 
that there is a section where all three smaller circles intersect, for the 
3-language-speakers.  If you now inspect the sections, it is easy to 
work out the numbers of one language-speakers and the non-
language-speakers.  This takes longer to describe than to do it !!

It is possible to solve the problem by jiggling with the numbers but 
the simplest method is to write down the numbers 1 to 36 to represent 
the guests.  Then write the letter “F” under the numbers 1 to 16   -   16 
French speakers.
Write the letter “E” under the numbers 1 and 2, and also the letter “G” 
under 1 and 2 -   2 speak all three languages.
Also, write “E” under numbers 3 to 6   -   these 4 also speak F and E  
(Total 6).
That leaves a further 8 English speakers.  Put “E” under numbers 17 
to 24.
Put “G” under number 7  -  three speak F and G  -  and under 17 to 19  
(E  +  G   -   5 in all).
That leaves a further 6 German speakers  ( 2   +   1   +   3  out of  12),  
so write “G” under numbers 25 to 30.
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1    2    3    4    5    6    7    8    9   10   11   12   13   14   15   16   17   18
F    F    F   F    F    F   F    F    F    F    F     F     F     F     F     F
E    E    E   E    E   E                                                                       E    E
G    G                          G                                                                 G    G

19   20   21   22   23   24   25   26   27   28   29   30   31   32   33   34   35   36
E     E    E     E     E     E
G                                        G    G     G    G    G     G   

Now, add them up to check for mistakes !
F   numbers 1 to 16,
E   numbers 1 to 6,  17 to 24   -   6  +  8  =  14,
G   numbers 1, 2, 7, 17 to 19,  25 to 30   -   1  +  1  +  1  +  3  +  6   =   12.
FE   numbers 1 to 6,  
FG   numbers 1, 2, 7   -   3 in all,
EG   numbers 1, 2, 17 to 19   -   5 in all.
FEG  numbers 1, 2.
Hence, 
(a) those speaking one language are numbers  8 to 16,  20 to 24,  25 to 30   -

9   +   5   +   6   =  20.
(b) Those speaking no language are numbers 31 to 36, ie.  6.

How many of you got the answers right?

Some New Puzzles
1.  A                F G          J     L    

B CD E           H I    K
Put the remaining letters of the alphabet above or below the line as you think.

2. A rich man once gave 50p to every boy in his home town and 30p to
every girl (Sex discrimination!). All the girls accepted the money but 40% of 
the boys refused it. If there were 2000 children altogether (not necessarily 
equal numbers of boys and girls), how much money did the man pay out?

3. A very old puzzle involving pouring from containers.
Three jugs have capacities of  8 pints, 5 pints and 3 pints respectively. 

The 8-pint jug is full of water and the other two are empty.

How can you arrange to have 4 pints in each of the two large jugs?

  Derick Alliban  Answers as usual in the next Newsletter
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Sharing Text between 
Word Documents
There is sometimes a need to share text 

between 2 different documents – sometimes it 
is possible to just copy and paste, but if there is a lot of text to be 
shared, in different places, then ensuring that everything has been   
updated can be very hard!

Word offers several ways around this, some are easy (as 
shown here) others more complicated involving mail merging etc. 
Let’s see the easy way!

1. For this to work we need at least 3 documents:
a) share.doc – contains the text etc to be shared.
b) doc1.doc – the first document
c) doc2.doc – the second document

If more than one piece of text needs to be shared it is best to 
create a separate share.doc for each one, or things can get 
confusing!

It is also possible to have more than two documents the text is 
going into.

2. First you need to create all of the documents containing the 
text to be shared, give them names that will be easy to refer 
to in future.

3. Now open (or create) the first document that has to have the 
share – find the point that needs to have the shared text in-
serted and 

i) Go to Insert
ii) Select File
iii) Find the file containing the text and click it ONCE to 
select it
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iv) In the bottom of the window, use the drop down 
box where it says “Insert” to change the setting to 
“Insert as Link”

The text will now be inserted into the document, but linked 
to the original, so if the original text is changed it is     
reflected in this document as well! If you click the shared 
text it will appear shaded to show it is linked – RIGHT click 
and you can force it to update the link from the saved file.

4. Repeat steps as many times as necessary for all the shared 
text in each document.

Adrian.

GENDER BENDER 

PC MUST be Feminine because: 
The native language they use to communicate 
with each other is incomprehensible to anyone 
else! ! ! 

Tony Seager
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Here is another excerpt from that web site -
http://www.helldesk.org.uk

"Yesterday"
(to the Tune of "Yesterday", by the Beatles)

Yesterday,
All those backups seemed a waste of pay.
Now my database has gone away.
Oh I believe in yesterday.

Suddenly,
There's not half the files there used to be,
And there's a milestone hanging over me
The system crashed so suddenly.

I pushed something wrong.
What it was I could not say.

Now my data's gone
and I long for yesterday-ay-ay-ay.

Yesterday,
The need for back-ups seemed so far away.
I thought my data was all here to stay,
Now I believe in yesterday.
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Internet Topology
Over the last few months I have had several 

questions from club members asking how the internet 
is organised, and how it works. It seems that there is a great deal of 
confusion about this! This should give a quick introduction, and 
hopefully explain some of the internets more bizarre tendencies –
including explaining why all internet access in the UK is affected by 
how much is being used in America.

Much more information than is given below can be found 
from many sources – just search the internet!

All images below are taken from websites around the world –
notably from the Netsight JANET site at

 http://bristol.netsight.ja.net/start.php/backbone/geo.

Start by quickly looking at the history of the internet:

The first useful point is that networking computers on a large scale 
was a military invention, designed to allow data to be shared        
between installations, with many interconnections, so that if one site 
was destroyed communications could be maintained.

The internet as we know it can be traced back to a series of 
discussions held in 1962, this was for a “galactic network” whereby 
there would be a string of computers globally, all interconnected to 
allow anyone to access data and programs stored on them. Much 
work followed and the first section (or node to use internet           
terminology) of the ARPANET was set up in September 1969 at 
UCLA in America. By the end of 1969 a total of 4 host computers 
had been added to the network!

Throughout the 1970’s the network was added to, and new 
technologies entered the plans. By 1980 there was a change in the 
way computers were designed, with more widespread use of work-
stations and LANs (local area networks) for business and             
educational sites. Gradually since this time the number of connected 
computers has increased, with the main backbone being increased 
along with it. There are a number of companies working to keep the 
main backbone active and growing – but no governing body, so it is 
impossible to say how many computers are using the internet today.

So that’s how the internet got going! But, how does it work 
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now – to explain a bit more, take a look at the picture below:

This diagram shows a topological view of JANET  (Joint Academic 
NETwork) as currently exists for universities and        colleges in 
the UK (and shared to a certain extent by all UK internet connec-
tions)– the big blue circles are the main nodes of the system, and it 
can easily be seen that if one is removed, all the others       can still 
communicate. The different thicknesses of the lines is     representa-
tive of the data speeds that can be accommodated on the connecting 
lines – the thin lines on the diagram are about 100Mbit lines (that’s 
100 Mega bits per second – about 1800 x faster than the best dial-up 
connection you will ever get on your phone line).

The topological view makes it easier to understand – but for those 
that like to see where things fit together, here’s the geographical 
layout:

The London node is the most 
important, as it contains the links to the rest of the world – looking 
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at the view below should explain why surfing the internet is easier 
before America starts it’s business (and why it’s sometimes quicker 
for things to go via Japan!):

Communications on the internet generally follow a simple route –
the quickest – rather than the shortest. The route will vary every 
time as different internet nodes handle different amounts of traffic. 
Hence it is sometimes quicker for an e-mail to be sent along a faster 
link (even if it means going several times around the world!) than an 
individual segment between adjacent nodes.

I will just show the picture below – this shows quantities of 
internet communication in Europe during October 2000

If you have any more questions about the internet, let me know!

Adrian
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For our final contribution to this newsletter we 
leave the subject of computers for a minute to tell 
you:-

How To Give A Cat A Pill
1) Pick cat up and cradle it in the crook of your left arm as if 
holding a baby. Position right forefinger and thumb on either side of 
cat's mouth and gently apply pressure to cheeks while holding pill in 
right hand. As cat opens mouth, pop pill into mouth. Allow cat to 
close mouth and swallow.
2) Retrieve pill from floor and cat from behind sofa. Cradle cat 
in left arm and repeat process.
3) Retrieve cat from bedroom, and throw soggy pill away.
4) Take new pill from foil wrap, cradle cat in left arm, holding 
rear paws tightly with left hand. Force jaws open and push pill to 
back of mouth with right forefinger. Hold mouth shut for a count of 
ten.
5) Retrieve pill from goldfish bowl and cat from top of       
wardrobe. Call partner from garden.
6) Kneel on floor with cat wedged firmly between knees, hold 
front and rear paws. Ignore low growls emitted by cat. Get spouse to 
hold head firmly with one hand while forcing wooden ruler into 
mouth. Drop pill down ruler and rub cat's throat vigorously.
7) Retrieve cat from curtain rail, get another pill from foil wrap. 
Make note to buy new ruler and repair curtains. Carefully sweep 
shattered figurines and vases from hearth and set to one side for   
gluing later.
8) Wrap cat in large towel and get partner to lie on cat with head 
just visible from below armpit. Put pill in end of drinking straw, 
force mouth open with pencil and blow down drinking straw.
9) Check label to make sure pill not harmful to humans, drink a 
beer to take taste away. Apply Band-Aid to partner's forearm and 
remove blood from carpet with cold water and soap.
10) Retrieve cat from neighbour's shed. Get another pill. Open 
another beer. Place cat in cupboard, and close door onto neck, to 
leave head showing. Force mouth open with dessert spoon. Flick 
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pill down throat with elastic band.
11) Fetch screwdriver from garage and put cupboard door back 
on hinges. Drink beer. Fetch bottle of scotch. Pour shot, drink.    
Apply cold compress to cheek and check records for date of last 
tetanus shot. Apply whisky compress to cheek to disinfect. Toss 
back another shot. Throw T-shirt away and fetch new one from   
bedroom.
12) Call fire department to retrieve the F@#%!%G cat from tree 
across the road. Apologise to neighbour who crashed into fence 
while swerving to avoid cat. Take last pill from foil wrap.
13) Tie the little bastard's front paws to rear paws with garden 
twine and bind tightly to leg of dining table, find heavy duty     
pruning gloves from shed. Push pill into mouth followed by large 
piece of steak fillet. Be rough about it. Hold head vertically and 
pour 2 pints of water down throat to wash pill down.
14) Consume remainder of scotch. Get partner to drive you to 
A&E, sit quietly while doctor stitches fingers and forearm and     
remove pill remnants from right eye. Call furniture shop on way 
home to order new table.
15) Arrange for RSPCA to collect mutant cat from hell and call 
local pet shop to see if they have any hamsters  ..........
~

How to give a dog a pill.
1. Wrap it in bacon.

Margot Whitcombe

For Sale or Wanted

There are no items offered in this section this month.
If you have anything you wish to sell or happen to be looking for 
please fill in the form on the opposite page and hand it to either  
myself  or Adrian.
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Items for Sale/Wanted
If you have an item for sale/wanted, please fill in the section 

below (or write the same information on a separate piece of paper) 
and send it to me, or hand it to me at a meeting .

Name: 
___________________________________________________

Telephone: 
___________________________________________________

E-mail: 
___________________________________________________

Is the item for sale, or wanted (please delete)?:
FOR SALE   /    WANTED

Description: 
____________________________________________________

_____________________________________________________

_____________________________________________________

_____________________________________________________

Price wanted/Willing to pay:   £ ________________________

Date: ______________________________
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